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Virtualna šetnja izložbom „Upoznajmo Frankopane“

„Od Dujma do Frana Krste, od Krka do Bečkoga Novog Mjesta, od 
1118. do 1671. godine... više od pet i pol stoljeća hrvatska povijest neza-
misliva je bez Frankopana. Nema te važne društvene i političke dužnosti 
i uloge koju nisu obnašali; bili su kneževi, banovi, potkraljevi i ratnici, 
podupiratelji umjetnosti i pjesnici, a na kraju i politički prevratnici u po-
trazi za boljim svijetom. Iza njih su ostajali zakonici, statuti i druge važ-
ne uljudbene isprave, zabilježene na hrvatskome jeziku glagoljičkim pi-
smom. U njihovoj lozi bilježi se niz od 114 Frankopana u 17 naraštaja.“1

Sažetak

Cilj ovoga videozapisa bio je omogućiti korisnicima nov način da pogledaju 
izložbu online pomoću standardiziranoga 360 pregleda na servisu YouTube. 
Predstavljena je izložba „Upoznajmo Frankopane“, nastala u sklopu projekta 
kulturno-turističke rute „Putovima Frankopana“ Primorsko-goranske župa-
nije i Pomorskog i povijesnog muzeja Hrvatskog primorja Rijeka.
Videozapis je sniman kamerom Insta 360 One R TwinEdition s dvostrukom 
360 lećom i pomoću nevidljivoga štapa Insta, a uređivan je u programu Ado-
be Premiere. Videosnimci je pridružena prigodna instrumentalna glazba, 
koju je za Primorsko-goransku županiju skladao Elvis Stanić. Korištena teh-
nologija 360 videozapis omogućuje korisniku da prošeta izložbom i pogleda 
kako je postavljena u prostoru. S obzirom na to da su u trenutku postavljanja 
videosnimke na YouTube kanal vrijedile restrikcije dolaska u muzeje zbog 
pandemije bolesti COVID-19, videosnimka je bila alternativni način komu-
nikacije Muzeja s korisnicima. Također, poslužila je i kao poticaj i pozivnica 
korisnicima da posjete Muzej u trenutku kada se njegova vrata otvore u pot-
punosti.
Ključne riječi: 360 videozapis, Pomorski i povijesni muzej Hrvatskog pri-
morja Rijeka, izložba „Upoznajmo Frankopane“, virtualna šetnja, YouTube

Abstract

The goal of this video was to provide users with a new way to view the 
exhibition online using the standardized 360-degree view on YouTube. The 
exhibition “Let’s Get to Know the Frankopans” was presented, which was 

1	 Putovima Frankopana. Upoznajmo Frankopane. [citirano: 2022-12-06]. Dostupno na: https://frankopani.eu/
frankopani/
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created as part of the cultural-tourist route project “The Routes of the Fran-
kopans” of the Primorje-Gorski Kotar County and the Maritime and History 
Museum of the Croatian Littoral Rijeka.
The video was recorded with the Insta 360 One R TwinEdition camera, fea-
turing a double 360-degree lens, using the Insta invisible stick, and edited us-
ing the Adobe Premiere software. The video is accompanied by appropriate 
instrumental music composed by Elvis Stanić for the Primorje-Gorski Kotar 
County.
The 360-degree video technology used allows the user to walk through the 
exhibition and see how it is set up in the space. Given that at the time the 
video was uploaded to the YouTube channel, restrictions on visiting muse-
ums were in effect due to the COVID-19 pandemic, the video served as an 
alternative way for the Museum to communicate with its users. Additionally, 
the video served as an incentive and invitation for users to visit the Museum 
when its doors are fully opened again.
Keywords: 360 video, Maritime and History Museum of the Croatian Lit-
toral Rijeka, “Let’s Get to Know the Frankopans” exhibition, virtual tour, 
YouTube

1. Uvod

Izložba „Upoznajmo Frankopane“ nastala je u sklopu projekta Kultur-
no-turističke rute „Putovima Frankopana“ Primorsko-goranske županije i 
Pomorskog i povijesnog muzeja Hrvatskog primorja Rijeka, koji se teme-
lji na istoimenom projektu koji je Primorsko-goranska županija provodila 
u razdoblju od 2005. do 2008. godine. Obnovom jedne od kula na kaštelu 
u gradu Krku simbolično je označen „početak obnove frankopanske bašti-
ne. Nastavilo se od 2013. do 2016. godine proširenjem na ukupno dvadeset 
objekata Krka, Rijeke i Gorskog kotara, a uređen je i prvi Posjetiteljski cen-
tar Kraljevica, s namjerom stvaranja kulturno-turističke rute. Treća faza za-
počela je 2015. godine prijavom projekta Kulturno-turistička ruta ‘Putovima 
Frankopana’ na natječaj Ministarstva regionalnoga razvoja i fondova EU, a 
projekt je potrajao do svibnja 2021.“2 Projekt je osvojio drugu nagradu Eu-
ropske mreže kulturnog turizma, a proglašen je i najuspješnijim županijskim 
projektom prema izboru javnosti, glasanjem čitatelja „Jutarnjeg lista“.

2	 Putovima Frankopana. O projektu. [citirano: 2022-12-06]. Dostupno na: https://frankopani.eu/o-projektu/
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Izložba „Upoznajmo Frankopane“ bila je otvorena od 28. siječnja do 20. 
ožujka 2022. godine, a za njezino online razgledavanje zaslužan je 360 vi-
deozapis produciran u Muzeju i postavljen na YouTube kanal Muzeja i You-
Tube kanal projekta. Izložba je posjetitelje upoznala s Kulturno-turističkom 
rutom „Putovima Frankopana“, svim lokacijama rute, interpretacijskim cen-
trima, multimedijalnim sadržajem te mnogim aktivnostima provedenim u 
sklopu tog velikog županijskog projekta. Osim toga, kao posebna zanimlji-
vost, u Rijeci su prvi put izloženi i kostimi Jurja Zigmana posebno kreirani 
za „Putove Frankopana“.

Videozapisi od 360 stupnjeva, također poznati kao surround videozapisi, 
imerzivni videozapisi ili sferični videozapisi, jesu videosnimke u kojima se 
pogled u svim smjerovima bilježi u isto vrijeme, snimljene višesmjernom 
kamerom ili zbirkom kamera. Tijekom reprodukcije na normalnom rav-
nom zaslonu gledatelj ima kontrolu nad smjerom gledanja poput panorame. 
Također se može reproducirati na displeju ili projektorima raspoređenima 
u kuglu ili neki dio kugle. Izložba je dostupna na adresi https://youtu.be/
zQY2D1P6jQI.

Snimanje 360 videozapisa

Za snimanje videozapisa korištena je kamera Insta 360 One R s duplom 
lećom (dual-lens 360), postavljena na nevidljivi štap za selfie (invisible selfie 
stick) Insta 360. Insta 360 One R akcijska je modularna kamera koja 360 
videozapise snima u 5,7 K rezoluciji s glatkom stabilizacijom slike i HDR 
modom za dobro osvjetljenje slike i prirodne boje (slika 1).

Slika 1. Kamera Insta 360 One 
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Snimanje je provedeno tako da je zaposlenica Muzeja, pomoću nevidlji-
voga štapa za selfie, držala kameru iznad glave te polako šetala kroz izložbu 
u trajanju od 1 minute i 20 sekunda. Početni format videosnimke bio je .insv, 
što je standardni panoramski videoformat snimanja kamerom Insta 360. Ve-
ličina snimljenog videozapisa jest 5760 x 2880 px, što je zapravo veće od 
4K standarda (3840 x 2160 px), dok je brzina prijenosa 100 Mbps, a broji 25 
sličica u sekundi.

Nakon što je materijal snimljen, datoteka se prebacuje na računalo i otva-
ra u aplikaciji Insta Studio kako bi se izvršila konverzija u „standardni“ MP4 
format za pregled 360 videozapisa. U toj je aplikaciji vrlo jednostavno izre-
zati određene dijelove videosnimke. Pomoću alata Trim start i Trim end na 
vremenskoj crti videosnimke označi se početak i kraj rezanja, a samo reza-
nje izvodi se prilikom eksporta videosnimke. Najčešće su to početak i kraj 
kako bi se uklonili nepotrebni dijelovi videozapisa, kao što su uključivanje 
i namještanje kamere te isključivanje kamere. Prije nego što se film konver-
tira, potrebno je postaviti određene parametre u aplikaciji za stabilizaciju 
slike prilikom kretanja ili za zaključavanje pravca kretanja (FlowState sta-
bilization i Direction lock) te dodati logo projekta na dno snimanja kamere 
(slika 2).

Slika 2. Insta Studio – postavljanje logotipa projekta na dno snimanja kamere
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Nakon što je sve potrebno podešeno, pokreće se konverzija videosnimke 
u MP4 te se tom prilikom namještaju i parametri konverzije (360 videoza-
pis, brzina prijenosa, rezolucija i format enkodiranja). Potrebno je upozoriti 
da videosnimka na većini plejera koji ne mogu podržati 360, izgleda kao 
razvučeni „panoramski“ videozapis koji nije ugodan za gledanje. 

Montiranje 360 videozapisa

Nakon što je konverzija videosnimke u format MP4 gotova, nova datote-
ka importira se u aplikaciju Adobe Premiere Pro te se započinje s montažom 
videosnimke. Na početku treba postaviti napisan naslov s logotipom Muzeja 
i logotipom projekta u 360 okruženju. Na kraju se dodaju zasluge, koje tako-
đer izgledaju „malo udaljeno i nakrivljeno“ jer su u 360 okruženju. To se sve 
može pripremiti u programu Adobe Photoshop.

U programu Adobe Photohsop potrebno je napraviti pripremu, ali na slici 
rezolucije 5760 x 2880 px, što je i rezolucija videosnimke. Nakon što je sve 
pripremljeno, potrebno je postaviti efeket Spherical Panorama te izvoz u 
.jpg datoteku kako bi prilikom uvođenja u program Adobe Premiere Pro sve 
bilo usklađeno (slika 3).

Slika 3. Postavljanje naslova odabirom efekta Spherical Panorama u programu Adobe 
Photoshop
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Kod 360 videozapisa često centar odnosno početni fokus nije postavljen 
onako kako želimo pa se zapravo na startnom frameu pokazuje slika „sa 
strane“ ili „pozadina“, a to nije ono otkud želimo krenuti pa je to potreb-
no na početku i postaviti. To se može postaviti efektom VR Rotate Sphere, 
koji se nalazi ovdje: Effect → Video Effect → Imersive Video. Za korištenje 
tog efekta potrebno je imati grafičku karticu u računalu jer je za njegovu 
obradu potrebna veća brzina GPU-a (grafičkog procesora). Brzina GPU-a 
dobro dođe i na kraju prilikom eksportiranja videozapisa. Postavljanje har-
dverskoga ubrzanja (hardware acceleration) ovisi o verziji aplikacije pa se u 
verziji Adobe Premiere 2020 postavljalo ovako: Edit → Preferences → Me-
dia (treba uključiti opciju Enable hardware accelerated decoding), dok je u 
novijoj verziji tu opciju potrebno uključiti ovako: File → Project Settings → 
General → (u opciji Renderer treba izabrati Mercury Playback Engine GPU 
Acceleration) (slika 4).

Slika 4. Postavljanje VR Rotate Sphere u programu Adobe Premiere

Tu je, prema želji, potrebno namjestiti Pan (Y os), što je, primjerice, na 
ovoj videosnimci 180° te eventualno podesiti Tilt (X os) ili Roll (Z os).

Budući da je kamera snimila i zvuk, postojeći zvuk moguće je ukloniti te 
dodati željeni zvuk. To se jednostavno napravi tako da se klikne desnom tip-
kom na timeline videa/zvuka, izabere se Unlink te se ponovno označi samo 
zvuk i ukloni tipkom delete na tipkovnici. Izbor zvuka bila je melodija Elvi-
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sa Stanića u trajanju od 1 minute i 24 sekunda, koja se izvrsno uklopila s 
videosnimkom, međutim, bilo je potrebno napraviti prilagodbu videozapisa 
sa zvukom tako da su se određeni dijelovi videozapisa usporili. To je naj-
jednostavnije napraviti tako da se videozapis „uspori“ pomoću alata Time 
Remaping, kako bi se vrijeme trajanja videosnimke uskladilo sa zvukom. 
Također se to može napraviti s dijelovima videozapisa, a u ovom je primjeru 
to napravljeno na početku i na kraju videosnimke, tako da je ona usporena u 
odnosu na zvuk 50 % nekoliko sekunda. Time Remapping moguć je nakon 
desnog klika na timeline videozapisa: → Show Clip Keyframes → Time Re-
mapping. 

Nakon toga potrebno je spremiti promjene te je potrebno pokrenuti ek-
sport 360 videozapisa. Na prikazu eksporta potrebno je izabrati za koju se 
vrstu medija sprema videosnimka, potom naziv datoteke, unaprijed zadana 
kvaliteta i format enkodiranja. Vrijeme eksporta ovisit će o duljini samog 
videosadržaja, ali i opreme kojom raspolažete u računalu (slika 5).

Slika 5. Eksport 360 videozapisa u programu Adobe Premiere

Postavljanje na YouTube kanal

Kad je eksport gotov, imamo 360 videozapis u formatu MP4 koji je mo-
guće ispravno pokretati u aplikacijama koje dopuštaju pokretanje 360 video-
zapisa. Jedan od mrežnih servisa koji su prilagođeni da ispravno prikazuju 
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360 videozapis jest i platforma YouTube. Za postavljanje na YouTube kana-
lu dovoljno je biti prijavljen pomoću ispravnoga Google računa, s obzirom 
na to da je Google vlasnik servisa YouTube. Kad se u pretraživaču otvori 
YouTube, potrebno je u gornjem desnom kutu stranice kliknuti na oznaku 
kamere s plusom u sredini – Izradi pa od ponuđenoga izabrati „prenesi vi-
deo“. Otvorit će se YouTube studio (za uređivanje videozapisa) i dijaloški 
prozor za „povuci i ispusti“ (drag and drop) – tehniku unosa željenoga vi-
deozapisa. Nakon što je videozapis prenesen i pušten na prozor, automatski 
se počinje podizati na udaljeni server, a pritom se dijaloški prozor mijenja 
u formu za unos te je potrebno upisati naslov i opis videozapisa, izabra-
ti minijaturu, odrediti popis kojem pripada te publiku kojoj je namijenjen 
(„namijenjeno djeci“). Kada se odrede pojedinosti, polazi se na dodavanje 
elemenata videozapisa (titlovi, završni zaslon, kartice) pa provjere autorskih 
prava vezanih za dijelove videosadržaja (glazba) te na kraju vidljivost sa-
moga videozapisa („privatno“, „nije javno dostupno“, „javno“, „raspored“). 
Dobar dio pojedinosti jest opcionalan i naknadno izmjenjiv, ali svejedno je 
dobro odmah pripremiti naslov i opis, a što se tiče vidljivosti, dobro je da 
videozapis u početku „nije javno dostupan“ kako bi ga mogao vidjeti samo 
onaj korisnik kojem pošaljete poveznicu. Na taj način možete provjeriti vidi 
li više korisnika sve ispravno pa tek onda možete objaviti videozapis javno. 
Nakon što se videosnimka prenese i postane vidljiva, moguće je primijetiti 
lošiju kvalitetu (SD), dok se zapravo tek obrađuje viša kvaliteta (HD). Na-
kon nekog vremena završava se i obrada videozapisa u visokoj kvaliteti i 
videozapis je spreman za dijeljenje (slika 6).

Slika 6. Podizanje videozapisa na platformu YouTube 
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Zaključak

Izrada i postavljanje 360 videozapisa na platformu YouTube jednostavan 
je i relativno jeftin način za prezentiranje određenog sadržaja u prostoru. 
Trošak se svodi na cijenu akcijske 360 kamere (Insta 360 One R – oko 465 
€, 3500 kn) te nevidljivoga štapa (invisible selfie stick – oko 26 €, 200 kn) 
kojim ćete držati tu kameru ili pak kacige na koju se kamera može montirati. 
Postoji dosta besplatnih aplikacija za obradu 360 videozapisa, počevši od 
aplikacije koja dolazi sa samom kamerom (Insta studio). Osim što na zani-
mljiv i udaljen način možemo prošetati izložbom (online), vjerujem da se 
snimanjem i montažom 360 videozapisa, između ostalog, možemo koristiti 
kao dodatnim sredstvom za dokumentiranje postava pojedinih izložbi. Po-
sebno se to odnosi na, primjerice, „zvučnu izložbu“, koju smo jednom pri-
godom i imali u Pomorskom i povijesnom muzeju Hrvatskog primorja Ri-
jeka, pa je tom prilikom bio dodatni izazov dokumentirati zvuk u prostoru.

S obzirom na sve jeftinije 360 tehnologije te sve veću mogućnost obrade 
i pregledavanja 360 videozapisa „standardnim“ aplikacijama (VLC), sma-
tram da bi takav način prezentacije mogao postati standardan način poziva-
nja korisnika na izložbe u muzeje i galerije, ali i na druga događanja.
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